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User's Guide to the Ovako
TACIT Application

By Emil Åström, SICS.

Note: the GUI part is a shortened version of the actual User's Manual, which is written in
Swedish. This is the reason for the Swedish text in some of the images.

1. Description of the application
The Ovako problem is mainly divided into two parts:

1. allocation of charges to orders

2. planning the furnaces

This division is reflected in the application. The main window is concerned with the furnace
planning and there is another window where the allocation of charges is done.

The normal way of working with the application is

1. Get data (from Ovako's production systems or from files)

2. Do the allocation

x Do the important details by hand

x Complete the rest using the automatic allocation function

x If needed, modify the automatic allocation by hand

3. Add or modify planned stops

4. Make a plan

If the plan looks okay then it is used as a basis for the production. If it is not okay then the
user can modify the allocation or add planned stops and then make a new plan.

It is sometimes useful to experiment with the allocations, planned stops or the charge queue. It
then useful to store a set of different situations to be able to compare them. This is supported
in the application through the use of the plan list. In this case, the steps above is augmented
with

5. Add plan to plan list if it is interesting.

6. Compare the latest plan with the others in the list. If none of them is acceptable, go back
to 2 or 3.
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2. Introduction to the GUI
Three windows are shown when the system is started:

The main window, where the plans are visualised:

This is where plans are generated, states loaded and saved, plans are compared and breaks for
the rolling flows and the furnaces are set. When the application is used at Ovako's Hofors
facility, data is imported from the production systems by pressing the "Get data" button but
this is obviously not possible without the connection to their databases. So, when testing the
application the data has to be imported from files instead (described later).

The next window is the allocation window that shows the charge queue, the orders and the
allocations between them:

Allocations can be done manually or automatically
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The third window shows the current status of the pit furnaces:

These three windows will now be briefly described.

3. The main window
A Gantt chart covers the largest part of this window. The resources are the furnaces (the
brighter grey lines are empty positions between the furnaces so that the chart gives visual
clues about the actual spatial distance between the furnaces).

The colours of the tasks represent different furnace phases: green is charging, yellow heating,
blue soaking (constant temperature), pink is waiting. Decharging is a grey area where one line
for each ingot that is decharged is drawn (the colour of the line depends on which roller line
the ingot is scheduled for). These lines are also drawn below the furnace chart, where we have
a separate Gantt chart for the rolling lines.

The chart contains two vertical blue lines, the lighter one is the current time while the other
one is a marker. The marker can be set by right-clicking in the chart or by moving it with the
left mouse button pressed.
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At the bottom of the window there is a histogram that shows how many furnaces there are that
we could start decharging from.

Pressing the left mouse button on an ingot's decharging line shows information about it:

Dimension is given as a pair of a shape and a measure. In the example above we have sq 150
which means square-shaped with 150mm side. We also have rnd for round and göt for whole
ingots that should not be rolled at all.

Breaks or stops (a time interval when the resource is unavailable) can be given for each
furnace or rolling line independently, by first making sure that the Modify-button is marked,
and then dragging with the mouse in the Gantt chart. For the furnaces, the mouse must be in a
position such that the furnace is marked with a light grey background when the drag is started.

A break is removed by clicking on it or by choosing Remove all stops in the Tools menu.
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3.1. Menus
The most important menu entries will now be described.

The File  menu
x Print, Microsoft Windows

(Under Unix this entry is called Print Postscript)
Prints the Gantt chart to a printer. This requires Ghostscript
to be installed. Currently the path to the Ghostscript
executable is hardwired in the code, so the recommended
way to create a printout is to save the chart as a postscript file
and print that file using e.g. Ghostview.

x Save postscript
Save the Gantt chart as a postscript file.

x Load state
Used to load different problem scenarios into the system. The application is delivered with
several state files (see section 6).

x Quickload history
Shows history data in the Gantt chart. The history supplied is from a 4-week period in the
autumn of 1997.

x Load and Save situation
Loads and saves the entire state of the system. Very useful for debugging and discussions
about the behaviour of the system. A situation contains more information than a state, for
example planned stops, more allocations (a state contains allocations only for charges in
the furnaces).

x Exit
Exits from the system.
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The View menu
x Plan in text format

Shows the plan in text format. This is useful if the user
wants detailed timing information. Each operation is
listed on one line and the lines are sorted in chronological
order.

x Legend:
Show a window that describes the colour coding of the Gantt chart.

x Show charge id
If enabled, draw the charge id next to the charging phase in the Gantt chart.

x Show flow colours
If enabled, the decharging lines have different colours depending on which roller line the
ingots will go to. If disabled, all lines are black.
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The Tools menu
x Make plan

Creates a new plan. Clicking on any of the Make plan
buttons in the other windows has the same result.

x Clear chart
Clears everything from the Gantt chart. Note that
although the chart is empty stops that were created are
still stored internally. To remove them use Remove all
stops.

x Remove all stops
Deletes all planned stops, both in the chart and from the internal database.

x Start plan list, Add to plan list, Close plan list
Open, add to, and close the plan list. The plan list is used for comparing different plans.

To use it, make a plan (including planned breaks and the allocation) and then choose Add
to plan list to add this situation to the list. Then modify the plan by changing the
allocation or the breaks and add the new plan to the list.

The plan list contains a simple cost measure that helps when comparing
(it's essentially the total time spent in a furnace, including waiting time).
The smaller this value is the better the plan (in some sense). The cost
measure for the latest plan can always be found in the upper right corner
of the main window.

To choose a plan from the list, double-click on it.

What-if analyses
The plan list can be used for what-if analyses by modifying the premises (allocation,
breaks) together with the plan list functions.

For example, it is possible to compare the outcome of shutting down a furnace at different
times (for maintenance for example). One could also see if there would be different results
if another furnace was shut down instead.

Or maybe one wants to see if a furnace can be switched off without lowering production?
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Or why not experiment with different allocations so that the problems with turning off
furnaces or rolling lines can be minimised or eliminated?

If the charges are coming in too quickly so that the rolling mill cannot keep up, then the
user can experiment with delays in the charge queue to see how it affects the plans. When
suitable delays (which charges and how much too delay) have been found, these can be
requested from the steel works.

The whole idea with these what-if analyses is that we can foresee problems and also solve
them before they occur.

4. The allocation window
This is where the allocations are made. There are two lists of charges and orders respectively,
and lines connecting entries in the two lists. The number in the middle of the line is the
number of ingots.

The blue lines are for charges in the furnaces (those charges are also blue), red ones are fixed
allocations that should not be changed, and the rest are black.

Each charge and order show how many unallocated ingots they contain. An allocation should
only be between a charge and order that have the same steel grade and the PB code for the
charge should be t than the PB code for the order.

Charges with darker background have a mark of 9 and have to be treated manually, i.e. they
are not automatically allocated.

The orders are sorted w.r.t. their due dates (given in days from today) and the charges are
listed in the incoming order.

To create an allocation manually, right-click on a charge and choose Allocate to order from
the appearing popup menu. The compatible orders are then marked with red markers. Click on
an order to create the allocation. There might be warning messages complaining about illegal
combinations of charge and order and these warnings can be overridden for flexibility
reasons.

An allocation can be removed by right-clicking on a line and choosing Delete from the popup
menu. One can remove entire subsets of the allocations using the Operations menu in the
bottom of the window.
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An allocation can be changed by dragging one of the endpoints of a line to a new
charge/order. An allocation can also be modified by right-clicking on it and choosing Edit
from the popup menu.

Clicking on a charge or order shows all compatible entries in the other list.

It has already been mentioned that a popup
menu is shown when right-clicking on a
charge. This menu contains the following
commands:

x Allocate to order
Create an allocation for the charge.

x Remove allocations to X
Removes all allocations that involve the charge.

x Put away ingots
If some ingots of a charge should not be charged into a furnace but rather put away for
future use, then this command should be used.

x Delay X and the following charges
Charges are assumed to arrive with approximately 65-minute intervals. This command can
be used to adjust the interval between the current charge and the previous one.

The Operations menu contains actions related to
allocations. Some useful commands in the menu will
now be described.

x Show allocations
Opens a textual list with all allocations. This is
useful if the graphical representation becomes too
cluttered.

x Add allocation
Can be used to add an allocation although it is mostly more convenient to use the popup
menu of the charges.

x Automatic allocation
This command completes the allocation automatically. This is useful since allocations can
be tedious to do manually. Automatic allocations can of course be modified afterwards, in
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the normal way. Note that an automatic allocation is always done when planing, so it is
often not necessary to execute this command manually.

x Remove an allocation, etc.
Removes different subsets of allocations.

All allocations are removed when a new state is loaded from file, except those of the manual
ones that have their charge and order also in the new state. This is useful since if the
allocation was done manually, it was probably important in some way, so it should be saved.

The system does not schedule unallocated ingots. However, when scheduling is initiated, the
user is warned if any of the charges contain such ingots:

Note that the rest of the ingots in a charge are scheduled even if some ingots are unallocated.

5. Furnace status window
This window simply shows some data about each furnace, such as it's current phase,
temperature, and charge.
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6. The scenarios
Together with the application we include a few example data files. These can be loaded using
the File/Load state menu entry of the main window.

Filename Description Tips

no_sol.pl,

no_sol2.pl

Mostly small round dimensions
and some square. The small
round flow is a bottleneck.

The round flow is a bottleneck
so we should try to replace some
of the round orders with square.
However, there is very little
square orders at this time so one
can use the orders with whole
ingots (dimension = göt) or try
to replace several small
allocations to one charge with
larger ones.

ovako1.pl,

ovako2.pl

Only small round dimensions,
tight schedule, much waiting

Here too there are very little
square orders to use. One can try
to replace several small
allocations with larger ones, but
in fact, this plan is so tight that
requests to the steel works to
stop for a while might be
motivated. For example try to
delay charge P4672 in ovako1.pl
with 60 minutes and observe the
improvement in the cost
measure.

ovako_980602.pl About equal amounts of round
and square, relatively tight
schedule

Only minor improvements can
be made since the allocation
already is rather balanced. There
are some square orders that can
replace a few of the round ones
but one must remember to
respect the due dates.

history/* These files are derived from
historical data. Due to the lack
of some information in the
historical data, some
information has to be
randomised. This means that
these files are not entirely
realistic but they may be
interesting to try out
nonetheless.

These files are rather different in
nature so no general tips can be
given.

To try them out, just load the respective files and press Make plan. Say yes to any warning
messages that may show up. Inspect the generated plan to see if there are any obvious
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improvements that could be made, or simply follow the tips in the table above. Make a new
plan to see if it has improved.

7. The end
In the event that you have problems or questions with the application, please contact

Emil Åström, SICS
emil@sics.se
+46-8-752 15 87


